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Axis Coverage Shapes for Microsoft® Visio® fournit des modèles de caméras de sécurité CAO 2D interactifs à utiliser dans
Microsoft® Visio®. Les modèles de caméras peuvent être placés dans un plan d'étage à l'intérieur de Visio pour visualiser le champ de
vision des caméras et intégrer la planification du système de surveillance dans vos conceptions.

Ce manuel est basé sur Microsoft® Visio® Standard 2016. Les options du menu peuvent être différentes dans d'autres versions de Visio.

L'utilisation d'Axis Coverage Shapes pour Microsoft® Visio® est soumise aux conditions générales de licence des logiciels Axis.

Démarrage

Télécharger les fichiers

Ce manuel part du principe que vous connaissez Microsoft® Visio®. Si vous avez besoin d'aide pour utiliser Visio, consultez le
siteAide de Microsoft® Visio®.

1. Téléchargez le fichier zip Axis Coverage Shapes pour Microsoft® Visio® depuis axis.com/tools/axis-coverage-shapes

2. Effectuez l'extraction des fichiers sur votre disque local (C:) vers Documents\My Shapes.

Ajouter Coverage Shapes à Visio

1. Ouvrez Microsoft® Visio® et ouvrez le volet Shapes (Formes).

S'il ne s'ouvre pas ou n'est pas visible, accédez à View (Afficher) > Task Panes (Volets) et sélectionnez Shapes (Formes).

2. Dans Shapes (Formes), sélectionnez More Shapes (Plus de formes) > My Shapes (Mes formes) où vous pouvez
sélectionner le groupe ou les groupes de Coverage Shapes que vous avez téléchargé(s).

3. Lorsque vous y êtes invité, sélectionnez Trust all from publisher (Faire confiance à tous les contenus provenant de
l'éditeur) ou Enable Macros (Activer les macros) dans l'avis de sécurité Microsoft® Visio®. Vous devez activer les macros
pour pouvoir utiliser les Coverage Shapes.

Vous disposez désormais des familles de caméras sélectionnées dans le volet Shapes (Formes).
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Importer un plan d'étage
La conception d'un système dans Microsoft® Visio® commence généralement par l'importation d'un plan d'étage.

Avant de commencer

Consultez nos conseils pour et .

Importer un dessin CAO

Vérifier l'échelle du fichier AutoCAD

1. Pour vérifier ou modifier l'échelle du fichier AutoCAD avant l'importation du fichier, ouvrez la boîte de dialogue Plot (Tracé)
dans AutoCAD et notez ou modifiez l'échelle. Pour plus d'informations, consultez les tutoriels AutoCAD correspondants.

Importer le fichier AutoCAD avec lequel travailler

2. Pour importer un fichier AutoCAD, ouvrez Microsoft® Visio® et accédez à Insert > CAD Drawing (Insérer > Dessin CAO).
Sélectionnez le fichier à importer et cliquez sur Open (Ouvrir).

3. Dans la boîte de dialogue CAD Drawing Properties (Propriétés du dessin CAO), définissez les paramètres CAD drawing
scale (Échelle du dessin CAO) et assurez-vous que les cases Lock size and position (Verrouiller taille et position) et Lock
against deletion (Empêcher la suppression) sont cochées.

Si vous rencontrez des problèmes lors de l'importation du fichier dans Microsoft® Visio®, essayez de sauvegarder le fichier
AutoCAD en tant que dessin R14/LT98/LT97. Pour plus d'informations, reportez-vous aux tutoriels AutoCAD.

Assigner un calque de caméra à l'image

4. Avant d'ajouter des caméras, assurez-vous de bien vérifier l'échelle du plan d'étage importé. Accédez à Design > Page Setup
> Drawing scale (Conception > Configuration de la page > Échelle du dessin) pour vérifier ou modifier l'échelle définie.

5. Accédez à Home > Editing > Assign to Layer (Accueil > Modification > Assigner à un calque) et créez un nouveau
calque qui servira de calque pour les caméras à ajouter. Accédez à Home > Editing > Layers > Layer Properties (Accueil
> Modification > Calques > Propriétés des calques), sélectionnez le calque nouvellement créé et marquez ce calque
comme Active layer (Calque actif).

Importer un fichier PDF

Il n'est pas idéal de travailler avec des fichiers PDF, car ce ne sont pas des fichiers vectoriels. Nous vous conseillons d'utiliser
un outil en ligne, tel que l'application Microsoft® PDF to JPEG pour convertir les fichiers PDF en fichiers image, ou de
faire une capture d'image du plan d'étage PDF afin de le sauvegarder comme un fichier image.

Importer l'image PDF avec laquelle travailler

1. Pour importer un fichier PDF, ouvrez Microsoft® Visio® et accédez à Insert > Object > Adobe Acrobat Document (Insérer
> Objet > Adobe Acrobat Document).
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2. Sélectionnez le fichier à importer et cliquez sur Open (Ouvrir).

Une fois l'importation terminée, assurez-vous d'adapter l'image PDF importée dans une seule page dans Microsoft® Visio®.

Si vous devez faire pivoter l'image, accédez à Home > Arrange > Position (Accueil > Organiser > Position).

3. Marquez le plan d'étage importé, accédez à Home > Arrange > Group (Accueil > Organiser > Grouper) et sélectionnez
Ungroup (Dissocier).

Définissez l'échelle de l'image PDF.

4. Pour pouvoir définir l'échelle de l'image, utilisez l'outil de mesure.

5. Une fois la mesure terminée, ouvrez une nouvelle page dans Microsoft® Visio® et accéder à Design > Page Setup >
Drawing scale (Conception > Configuration de la page > Échelle du dessin) pour saisir l'échelle définie.

Assigner un calque de caméra à l'image

6. Accédez à Home > Editing > Assign to Layer (Accueil > Modification > Assigner à un calque) et créez un nouveau
calque qui servira de calque de base à votre plan d'étage. Pour verrouiller le plan en place, accédez à Home > Editing
> Layers > Layer Properties (Accueil > Modification > Calques > Propriétés des calques), sélectionnez le calque
nouvellement créé et cochez la case Lock (Verrouiller).

Répétez cette étape pour créer un autre calque pour les caméras à ajouter. Dans la boîte de dialogue Layer properties
(Propriétés du calque), marquez ce calque comme Active layer (Calque actif).

Vous pouvez maintenant commencer à ajouter des caméras dans l'image de votre plan d'étage PDF.

Importer une image de carte

Au lieu d'importer une image de carte dans Microsoft® Visio®, nous vous conseillons d'essayer la fonctionnalité de cartes dans
Site Designer, qui offre un flux de travail fluide et fiable grâce à la fonctionnalité de carte intégrée.

Ajouter des caméras
Avant de commencer

Axis propose des mises à jour régulières de cette offre. Assurez-vous de toujours commencer par télécharger la dernière version sur
axis.com/tools/axis-coverage-shapes.

1. Une fois le calque des caméras défini dans votre plan d'étage, accédez à More Shapes > My Shapes (Plus de formes
> Mes formes) et sélectionnez les familles souhaitées. Répétez cette étape pour toutes les familles de caméras que
vous souhaitez charger dans votre conception.

2. Pour ajouter un modèle de caméra au plan d'étage, accédez aux familles de caméras sélectionnées et faites un
glisser-déplacer des modèles dans le dessin.

3. Modifiez les paramètres par défaut des modèles de caméras dans votre plan d'étage en fonction de votre conception.

- Pour contrôler les paramètres de champ de vision (FOV) du modèle de caméra, utilisez les poignées basculantes
jaunes du modèle. Les champs de données indiqués changent en fonction du repositionnement du FOV.

- Pour modifier les paramètres du modèle de la caméra, faites un clic droit sur le modèle de la caméra et
sélectionnez l'option Edit Shape Data (Modifier les données de la forme), où vous pouvez ajuster la plupart des
attributs de la caméra.

- Pour modifier le texte affiché pour le modèle de la caméra, faites un clic droit sur le modèle de la caméra et
sélectionnez Edit Text (Modifier texte). Mettez à jour le nom du modèle de caméra et cliquez sur ESC (ECH)
sur votre clavier.

- Pour copier un modèle de caméra existant dans d'autres emplacements au sein du même plan d'étage, faites un
clic droit sur le modèle de la caméra et utilisez les options Copy (Copier) et Paste (Coller).
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4. Pour ajouter un calendrier de caméra pour les modèles de caméras dans votre plan d'étage, faites un glisser-déplacer du
gabarit Axis Product Listing dans le dessin. Le gabarit inclura par défaut les modèles déjà placés dans votre plan d'étage.
Pour modifier le texte affiché dans la liste, faites un clic droit sur le champ de texte et sélectionnez Edit Text (Modifier
texte). Une fois vos changements ajoutés, cliquez sur ESC (ECH) sur votre clavier.

Exporter vers Site Designer
Pour pouvoir continuer à travailler avec votre plan de conception, vous pouvez exporter votre plan d'étage complet et vos modèles
de caméras dans AXIS Site Designer.

1. Enregistrez votre dessin dans Microsoft® Visio®.

2. Faites un clic droit sur une caméra dans votre dessin et sélectionnez Export all Cameras (Exporter toutes les caméras)

3. Dans la boîte de dialogue Export Cameras (Exporter les caméras), cliquez sur Export to Axis Site Designer (Exporter vers
Axis Site Designer). Une fois l'exportation terminée, une boîte de dialogue contextuelle s'affiche avec l'emplacement du
fichier d'exportation. Cliquez sur OK.

Remarque
Depuis cette boîte de dialogue, vous pouvez également exporter votre projet en tant que fichier séparé par des virgules dans
d'autres outils de planification (par exemple Microsoft Excel). Assurez-vous de sélectionner Comma (Virgule) en tant que
séparateur avant de cliquer sur Copy to Clipboard (Copier dans le presse-papiers).

4. Ouvrez Site Designer et sélectionnez Import project (Importer projet).

5. Accédez au fichier .asdp/.asdpx que vous souhaitez importer et cliquez sur Open (Ouvrir). Vous recevrez une notification
dans Site Designer une fois l'importation terminée.

Pour plus d'informations sur AXIS Site Designer, accédez à .

Infobulles
Cette section contient quelques idées utiles pour vous aider à utiliser Microsoft® Visio®. Nous vous recommandons de consulter les
pages d'assistance Microsoft® Visio® pour plus de détails et d'infobulles.

Création de modèles

Vous pouvez créer des modèles Microsoft® Visio® pour une taille de papier spécifique afin de vous aider à démarrer rapidement vos
projets. Utilisez la commande « Sauvegarder comme » pour vous assurer de ne pas apporter de modifications au modèle original.

Pages supplémentaires dans Visio

Suivez ces étapes pour ajouter une nouvelle page dans Microsoft® Visio® :

1. Dans la zone de dessin, faites défiler l'affichage vers le bas de la page et cliquez sur le signe de croix pour insérer une page.

2. Pour copier votre dessin existant dans la nouvelle page, sélectionnez (Ctrl + A) et copiez (Ctrl + C) vos dessins, puis
collez-les dans la nouvelle page (Ctrl + V).

3. Pour renommer la page, faites un clic droit sur la nouvelle page que vous avez créée et sélectionnez Renommer.

Outil de mesure

Pour faciliter la mise à l'échelle de vos projets, utilisez les outils de mesure dans Microsoft® Visio®.

1. Pour ajouter les outils de mesure au volet Shapes (Formes), accédez au volet Shapes (Formes) > More Shapes (Plus de
formes)> Visio Extras (Extras Visio) > Drawing Tool Shapes (Formes pour outil de dessin)

Sélectionnez Horizonal measure (Mesure horizontale) et Vertical measure (Mesure verticale) parmi les outils disponibles.
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2. Pour ajouter des outils de mesure à vos favoris, faites un clic droit sur Horizonal measure (Mesure horizontale) et/ou
Vertical measure (Mesure verticale) dans le volet Shapes (Formes), puis sélectionnez Add to My Shapes (Ajouter à
mes formes) > Favorites (Favoris).

Mise à l'échelle

Lorsque les dessins que vous créez contiennent des objets réels plus grands qu'une page imprimée, vous devez dessiner à l'échelle.
Nous vous conseillons de déterminer l'échelle d'un dessin avant d'importer un plan d'étage.

1. Accédez à File (Fichier) > New (Nouveau) et créez un nouveau projet.

2. Dans l'onglet Design (Conception), accédez à Page Setup (Configuration de la page) (Majuscule + F5) pour ouvrir
l'ensemble complet des options de formatage de la page.

3. Dans Page Setup (Configuration de la page), accédez à Drawing Scale (Échelle du dessin) et saisissez les détails de
l'échelle prédéfinie et/ou la taille de la page

6



Axis Coverage Shapes pour Microsoft® Visio®

Axis Coverage Shapes pour Microsoft® Visio®

Pour plus d'informations sur la mise à l'échelle, consultez l'aide en ligne de Microsoft® Visio®.
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Quel est l'avantage d'utiliser AXIS Site Designer par rapport à Coverage Shapes dans
Microsoft® Visio® ?
Par rapport à des produits sous licence comme Microsoft® Visio®, l'utilisation d'un outil en ligne gratuit, tel AXIS Site Designer pour
la planification de votre conception a plusieurs avantages.

• Vous êtes toujours à jour avec notre dernière offre de produits

• Vous obtenez une documentation projet complète, comprenant la facture des matériels, une estimation de la bande
passante, des propositions système et des rapports d'installation.

• Vous pouvez facilement parcourir et ajouter de nouveaux produits ou accessoires système à l'aide du sélecteur de produit
et d'accessoires intégré

• La conception de sites comprenant la configuration VMS, le positionnement de la caméra et les limites du champ de
vision est simple et facile.

• Vous pouvez importer les paramètres de la caméra et de l'enregistrement dans votre VMS et partager des notes et des
instructions d'installation avec les installateurs.

Vous pouvez en savoir plus sur AXIS Site Designer sur axis.com ou parcourir notre manuel pour plus d'informations.

Comment déplacer mon projet Visio® existant vers Site Designer ?
Pour pouvoir commencer à utiliser AXIS Site Designer avec vos projets existants créés à l'aide d'Axis Coverage Shapes pour Microsoft®
Visio®, vous devez exporter vos listes de caméras et vos plans tels que des plans d'implantation vers AXIS Site Designer.

• Pour exporter toutes vos listes de caméras, voir

• Pour importer votre tracé de Microsoft® Visio® vers Site Designer, suivez les étapes suivantes :

1. Pour masquer tous les champs de vision de votre tracé, faites un clic droit sur n'importe quelle caméra du projet
et supprimez la marque de contrôle Afficher le champ de vision.

2. Dans Microsoft® Visio®, allez à File > Export > Change file type > PNG.

Cliquez sur Save as et naviguez jusqu'à un emplacement de dossier où vous souhaitez enregistrer votre fichier
exporté.

3. Allez à sitedesigner.axis.com et connectez-vous à AXIS Site Designer.

4. Depuis la liste Mes projets, accédez au projet qui comprend vos listes de caméras récemment importées de
votre projet Visio.

5. Ouvrez votre projet, allez à Maps > Add new map > Upload floor plan.

Naviguez jusqu'au fichier .png que vous avez exporté depuis votre projet Visio.

6. Définissez l'échelle de l'image (comme vous l'avez utilisé pour votre projet Visio) et placez les caméras que vous
avez déjà importées de Visio.

Vous êtes prêt à travailler avec votre projet récemment importé dans AXIS Site Designer. Pour en savoir plus sur l'utilisation d'AXIS
Site Designer, accédez à axis.com ou parcourez notre manuel en ligne pour plus d'informations.
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